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Overview 

Stellar Phoenix Mailbox - Exchange Desktop is a complete convert Microsoft Outlook Offline 
Storage (OST) files to Microsoft Outlook Personal Storage (PST) files. 

What is OST File?  

If you use Outlook as an Exchange Server client and do not use PST file to store your data 
(instead store your data on the Exchange Server), OST file allows you to work offline. OST 
file acts essentially as an offline copy of your data store on the Exchange Server. When 
you're working offline, all changes that you make to contacts, messages, and other Outlook 
items and folders occur in the offline store. When you go online again, Outlook 
synchronizes the changes between offline store and your Exchange Server store. For 
example, if you've deleted messages from your offline store, Outlook deletes those same 
messages from your online store when you synchronize the folders. Any new messages in 
your Inbox on the server are added to your offline store. Synchronization is a two-way 
process, providing the most up-to-date copy of your data in both locations, ensuring that 
changes made in each are reflected in the other.  

An OST file is similar to a PST. The difference is that an OST file is RTF-aware, while a 
PST is not. The contents of any folder designated as an offline folder are included in the 
OST file, but the contents of the mailbox and other folders are not. 

Key features: 

• Enables user to view messages in 3-view format 

• Recovers e-mails, calendar entries, contacts, notes and journals 

• Restores formatting from RTF and HTML messages 

• Converted file is saved as new PST file on any (including network) disk visible by 
the host operating system 

• Creates unique profile for PST file 

• Supports MS Outlook 2000, 2002 (XP), 2003, 2007,and 2010 
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Stellar Phoenix Update Wizard 

The Stellar Phoenix Update Wizard keeps your Stellar Phoenix applications updated. 
Update option in the application checks for the latest updates available online. Stellar 
Phoenix Update Wizard checks for latest minor and major version available online. Stellar 
Phoenix Update Wizard automatically installs the minor version, if available. However, if 
major version available then you need to purchase it. While updating the software, it’s 
recommended to close all the running programs. 

To start Stellar Phoenix Update Wizard: 

1. In the Stellar Phoenix Mailbox - Exchange Desktop screen, Click Update Wizard 

 icon. the Stellar Phoenix Update Wizard window opens, click Next. The 
wizard will start searching for the latest updates and if it finds any new version, a 
window pops up indicating the availability. 

2. Click Next, the software will start downloading files from the server. When the 
process is complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

o Internet connection failure 

o Updates are not available 

o Unable to download configuration files 

o Unable to locate updated files or version 

o Unable to locate executable file 

If major version is available, to upgrade the software you have to purchase it. 
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Installation Procedure 

Before installing the software, ensure that your system meets the minimum system 
requirements: 

Minimum System Requirements 

• Processor: Pentium Class 

• Operating System: Windows NT4(SP6)/2000/XP/2003/Vista/Window 7 

• Memory: Minimum 256 MB (512 MB recommended) 

• Hard Disk: 50 MB of free space 

• MS Outlook: 2000, 2002 (XP), 2003, 2007, and 2010 

• Internet Explorer: Version 5 or later 

To install the software: 

1. Double-click StellarPhoenixMailboxExchangeDesktop.exe file to start the setup 
process. The Setup - Stellar Phoenix Mailbox - Exchange Desktop dialog box 
opens. Click Next. 

2. In the License Agreement screen, select I accept the agreement option. The Next 
button will be enabled. Click Next. 

3. In the Select Additional Tasks screen, check the required check boxes. Click Next. 

4. In the Select Destination Location screen, provide the path by using Browse button 
where the setup files will be stored. Click Next. 

5. In the Start Menu Folder screen, provide the path by using Browse button where 
the program's shortcuts will be stored. Click Next. 

6. In the Ready to Install screen, review the settings. Click Back to change settings. 
After confirming the settings, click Install. The Installing screen shows the 
installation process. 

7. After completing the process, the Completing the Stellar Phoenix Mailbox - 
Exchange Desktop Setup Wizard screen opens. Click Finish. 

Starting the Software 

To start the application, do one of the following: 
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• Click Start | All Programs | Stellar Phoenix Mailbox - Exchange Desktop, and then 
click Stellar Phoenix Mailbox - Exchange Desktop. 

• Double-click the shortcut icon of Stellar Phoenix Mailbox - Exchange Desktop 
from the desktop. 

• Click quick launch icon on the taskbar. 

 You can clear the Launch Stellar Phoenix Mailbox - Exchange Desktop check box to stop the automatic 
launch of the software. 
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How to Order? 

The software can be purchased by making payments online by using a credit card. Please 
visit http://www.stellarinfo.com/email-repair/convert-ost-pst/buy-now.php?Order for more 
information and to place an order. 

Alternatively, if the demo version is installed then on the Help menu, select Order Stellar 
Phoenix Mailbox - Exchange Desktop. This will open the home page of Stellar Phoenix 
Mailbox - Exchange Desktop from where you can purchase the software. You can also click 

Order Stellar Phoenix Mailbox - Exchange Desktop on the toolbar. The Order 
Stellar Phoenix Mailbox - Exchange Desktop opens, click the Buy Stellar Phoenix Mailbox - 
Exchange Desktop link to visit the home page from where you can purchase the software. 
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How to Register? 

If the software is downloaded from http://www.stellarinfo.com/email-repair/convert-ost-pst/buy-
now.php?Order  (i.e., ESD version), for the full functionality, the product must be registered using Serial Number 
(received through email after purchasing the product). 

If the software is installed using the product installation CD (i.e., BOX version), hardware lock[ ] is 
mandatory for the functioning of the software that is available with the software kit. 

After purchasing the software, you will receive the serial number, which is required to 
register the software. The serial number will be verified during the registration process and if 
the serial number is valid then the software will be registered. 

The software can be registered in different ways. These are the methods by using which 
you can register the software: 

o Over internet 

You should have the serial number, which is received after purchase of the software. 
On entering the serial number it is verified by license server and on verification the 
software will be registered. 

o Manual Activation 

You will need to generate a PHX_REG.txt file and mail the .txt file to 
support@stellarinfo.com. After verifying the serial number and purchase details of 
the software, the site key will be delivered to you at your email address. This site key 
is used to register the software manually. 
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Registration Over Internet 

To register the software over Internet: 

1. On the Activation menu, click Activate Stellar Phoenix Mailbox - Exchange 
Desktop Online. The Warning dialog box opens, click OK. 

2. In the Welcome to Stellar Phoenix - Electronic Software Registration wizard, click 
Next. 

3. Type the Serial number (received through email after purchasing the product) in the 
Serial number text box. Click Next. 

 

4. The software would automatically communicate with license server and register the 
software. Click Finish to complete the registration process. 

You can generate the PHX_REG.txt file manually by starting the online activation. View manual activation 
topic to perform the process of generating PHX_REG.txt file. 
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Manual Activation 

To register the software by using manual activation process: 

1. On the Activation menu, click Activate Stellar Phoenix Mailbox - Exchange 
Desktop Online. The Warning dialog box opens, click OK. 

2. In the Welcome to Stellar Phoenix - Electronic Software Registration wizard, click 
Cancel. 

3. The Stellar Phoenix Mailbox - Exchange Desktop dialog box opens, click OK. 

 

4. In the Stellar Phoenix Mailbox - Exchange Desktop -Manual Software Registra... 
dialog box, enter the serial number, which is received after the successful purchase 
of the software. Click Next. 

 

5. A file named PHX_REG.txt will be created at your desktop. Email the .txt file to 
support@stellarinfo.com email address. Click Finished. 
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6. In reply, you will receive the site key after checking the purchase details. This site 
key is required to activate the software manually. 

7. When you receive the site key, open Stellar Phoenix Mailbox - Exchange Desktop, 
on the Activation menu, click Manual Registration. In the Stellar Phoenix Mailbox - 
Exchange Desktop dialog box, enter the site key, which is received after sending 
the PHX_REG.txt file. Click Validate. 

 

The site key is delivered to your email address, which is used to sent the serial number. 
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User Interface 

Stellar Phoenix Mailbox - Exchange Desktop has a rich Graphical User Interface (GUI) with 
many features. The GUI of  Stellar Phoenix Mailbox - Exchange Desktop resembles the GUI 
of Microsoft Outlook Express. The  Stellar Phoenix Mailbox - Exchange Desktop has a two-
pain structure. The left-pane has Mail, Calendar, Contacts, Tasks, Notes and General tabs. 
Click a tab to view contents of it. All information related to an email such as sender's and 
recipient's address, subject date, and content is shown in the right-pane. The Find option 
helps to find particular mails.  The main user interface is as shown below. 

 

Click any tab to view contents of it.  

When you start Stellar Phoenix Mailbox - Exchange Desktop the Select Outlook Data File 
dialog box as shown below opens. You can select and search OST file by using this dialog 
box. 
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In this dialog box, the Select Outlook File button is used to open a OST file from known 
location. Find Outlook File button is used to search OST file in volumes. The Start button 
starts the recovering process. 

Stellar Phoenix Mailbox - Exchange Desktop has a toolbar and menubar having many 
options. 

The Select Outlook Data File dialog box is also opened by selecting Open Outlook File on the File menu 
 and by clicking the Open a Outlook File to Repair icon from toolbar. 
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Menubar 

The menubar of Stellar Phoenix Mailbox - Exchange Desktop has these menus and items: 

Menu Items 

File 

o Open Outlook File: Opens Select Outlook Data File 
dialog box by using which that allows you to search and 
select OST files. 

o Exit: Close the Stellar Phoenix Mailbox - Exchange 
Desktop. 

View 

o View Log Report: Shows log report generated by Stellar 
Phoenix Mailbox - Exchange Desktop's processes. 

o View Recovery Details: Shows the folders and number of 
files recovered from the selected PST file. 

Activation 

o Activate Stellar Phoenix Mailbox - Exchange Desktop: 
Starts the process of activating Stellar Phoenix Mailbox - 
Exchange Desktop by using Internet. 

o Manual Registration: Starts the process of manual 
activation of Stellar Phoenix Mailbox - Exchange Desktop. 

 

Help 

o Help Topics: Opens help guide of Stellar Phoenix Mailbox 
- Exchange Desktop. 

o Order Stellar Phoenix Mailbox - Exchange Desktop: 
Provides information regarding the purchase of Stellar 
Phoenix Mailbox - Exchange Desktop. 

o View Support Section: Opens the Stellar Information 
Systems Ltd.'s online support Web site where you can get 
online support. 

o View Knowledge Base: Opens the Stellar Information 
Systems Ltd.'s knowledge web site where you can find 
numerous number of knowledge base articles related to 
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data recovery concepts. 

o Submit an Enquiry: Allows you to submit an enquiry in 
Stellar Information Systems Ltd.'s online support Web site 
such that your query can be solved effectively. 

o About Stellar Phoenix Mailbox - Exchange Desktop: 
Provides general information and End User License 
Agreement (EULA) of the Stellar Phoenix Mailbox - 
Exchange Desktop. 
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Toolbar 

Stellar Phoenix Mailbox - Exchange Desktop has a toolbar with these tools: 

• : This icon opens the Select Outlook Data File dialog box by using which you 
can select and find OST files in your computer. 

• : This icon changes the right pane position. When you click a folder in left-
pane, by default, the right pane shows the details in horizontal columns position. 
You can click Switch Reading Pane icon to change the position to vertical columns. 

• : Opens the help guide of Stellar Phoenix Mailbox - Exchange Desktop. 

• : keeps Stellar Phoenix Mailbox - Exchange Desktop updated. Click this icon 
to run the update wizard, which download and install the newly available update for 
the Stellar Phoenix Mailbox - Exchange Desktop. However, if major version is 
available then you have to purchase the new version. 

• : Provides general information and End User License Agreement (EULA) of 
the Stellar Phoenix Mailbox - Exchange Desktop. 

• : Provides information regarding the purchase of the Stellar Phoenix Mailbox 
- Exchange Desktop. 

• : This icon allows you to save PST files at your preferred 
location. 

• : helps user to find particular mails. You can enter search 
criteria in respective text box to search mails. You can enter multiple values of 
parameter by using comma or semi colon as a separator.  
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Converting OST to PST 

If the location of OST file is known then you can directly specify the location and start 
conversion process of OST to PST. If you do not know the location then you can search the 
required OST file by using the search functionality of Stellar Phoenix Mailbox - Exchange 
Desktop. 

To convert OST files: 

1. In the Stellar Phoenix Mailbox - Exchange Desktop screen, on the File menu select 

Open Outlook File or click   icon to open the Select Outlook Data File dialog 
box and click Select Outlook File.  If file location is not known then search OST 
files in drives and folders and select the required OST file. 

2. In the Open dialog box, locate and select the OST file that needs to be converted 
and click Open. Click Start button to start scanning selected OST file. It may take 
few minutes to few hours to complete the scanning process depending on the size 
of the selected OST file. You can stop scanning process by clicking the Stop 
button, which appears after clicking Start button. 

 

3. After completion of scanning process, the Stellar Phoenix Mailbox - Exchange 
Desktop application window opens the OST file for preview. The recovery process 
details that is how many emails, Calendar entries, Contacts, Tasks, Notes and 
Journals are recovered is shown at the bottom of the window. 

After successful completion of scanning process, all recovered folders with number of files in them will be 
listed in the left-pane under root node. Click a folder to view emails stored in it. Click an email to read it. In addition, 
Mail, Calendar, Contacts, Tasks, Notes, and Journal tabs are given, click a tab to view its contents. You can also 

change reading pane from horizontal to vertical. Click  icon to change reading pane position. 

4. Click Save Recovered file icon, the Stellar Phoenix Mailbox - 
Exchange Desktop box opens, click Browse, in the Browse for Folder dialog box, 
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locate and select the location where the converted OST file should be saved. Click 
OK twice. 

 

PST file will be saved at the specified location. You will need to import the PST file to 
Microsoft Outlook to use it. 

If you stop scanning process then no file will be recovered. If you stop recovering process then only files 
recovered up to stopped point will be displayed. Also, Microsoft Outlook should be closed before starting scanning 
process.  
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Search OST files 

You can search for OST files by using Find Outlook File functionality of Stellar Phoenix 
Mailbox - Exchange Desktop. You can search OST files in drives, folders and sub folders. 
However, you can select only one drive to search OST files. 

To search OST files in drives: 

1. On the File menu, select Open Outlook File or click  icon on the toolbar to 
open Select Outlook Data File dialog box. 

2. In the Select Outlook Data File dialog box, click Find Outlook File button. 

3. In the Find OST File dialog box, under Search Options box, click Look in listbox to 
select drive. Select the required drive, and then click Start. 

 

4. In the Find OST File dialog box, under Search Results box, all OST files that are 
found in the selected drive will be shown. Click a file to select, and then click OK. 

 

You can click Clear List button to clear the result of search process and start a new search process. 

To search OST files in folders and subfolders: 
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1. On the File menu, select Open Outlook File or click  icon on the toolbar to 
open Select Outlook Data File dialog box. 

2. In the Select Outlook Data File dialog box, click Find Outlook File button. 

3. In the Find OST File dialog box, click Search in folder button. In the Browse for 
Folder dialog box, select a folder and click Start. In addition, if you want to search 
subfolders in that folder, check Search Subfolders checkbox. 

4. In the Find OST File dialog box, under Search Results box, all OST files that are 
found in the selected drive will be shown. Click a file to select, and then click OK. 
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Find, View and Save a Single Message 

Stellar Phoenix Mailbox - Exchange Desktop gives an option to find and save a specific 
message in the converted OST file. You can narrow the search with help of various search 
options given in the Find option. You can  save a message in the search result in EML or 
MSG format. 

 

To find messages in OST file,  

•  Click Find button in tool bar.  

• Specify the search options in Search Messages window. 

o In To box, specify all or few characters of e-mail ids of recipients. Key 
words should be separated by a semicolon (;). 

o In From box, specify all or few characters of e-mail ids of senders. Key 
words should be separated by a semicolon (;). 

o In Subject box, specify subject that will be searched. 

o In Date box, select date. All the mails received or sent on that date will be 
retrieved. 

• Click Find Now button to start search. 
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To View messages in the OST file, 

• After the search is over, the search result is shown in list. Double-click on mail 
message. It opens in new window. 

• Close the mail message after view. 

To save the message in the OST file, 

• Right-click the mail message in search result list. 

o Select MSG to save the message in MSG format. 

o Select EML to save the message in EML format. 

After the message is saved import it to view.   
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Import PST file 

To import PST file in Microsoft Outlook: 

1. Open Microsoft Outlook. On the File menu, select Import and Export. 

2. In the Import and Export Wizard, select Import from another program or file, click 
Next. 

3. In the Import a File box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, 
select an appropriate option. Click Next. 

5. In the Import Personal Folders dialog box, select the folders that should be 
imported in Microsoft Outlook. Click Finish. 
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Read .eml and .msg files 

To read an e-mail from a file saved as .eml: 

1. Navigate to the location where .eml file is saved or click  the link displayed in the success 
message dialog box. 

 

2. Double-click to open the file. The file opens as a regular e-mail in Outlook Express 
window. 

To read MSG files: 

• Navigate to the location where .msg file is saved or click  link displayed in the 
success message dialog box. 

 

• Double-click to open the file. The file opens as a regular e-mail in MS Outlook 
window. 
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Save Log Report 

You can save record of all processes of Stellar Phoenix Mailbox - Exchange Desktop in a 
text file. 

To save log report: 

1. On the View menu, select View Log Report. 

2. In the Stellar Phoenix Mailbox - Exchange Desktop box, click Save Log. 

 

3. In the Save As dialog box, specify the location where log file should be saved. Click 
Save. 

To clear log report: 

1. On the View menu, select View Log Report. 

2. In the Stellar Phoenix Mailbox - Exchange Desktop box, click Clear Log. 
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Copyright 

Stellar Phoenix Mailbox - Exchange Desktop software, accompanied user manual and 
documentation are copyright of Stellar Information Systems Ltd., with all rights reserved. 
Under the copyright laws, this user manual cannot be reproduced in any form without the 
prior written permission of Stellar Information Systems Ltd. No Patent Liability is assumed, 
however, with respect to the use of the information contained herein. 

Copyright © 1995-2010 by Stellar Information Systems Ltd. INDIA 
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Disclaimer  

The Information contained in this manual, including but not limited to any product 
specifications, is subject to change without notice. 

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD 
TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND 
HEREBY EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD 
TO ANY OF THE FOREGOING STELLAR INFORMATION SYSTEMS LTD ASSUMES NO 
LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR INDIRECTLY FROM ANY 
TECHNICAL OR TYPOGRAPHICAL ERRORS OR OMISSIONS CONTAINED HEREIN 
OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE MANUAL. IN NO 
EVENT SHALL STELLAR INFORMATION SYSTEMS LTD, BE LIABLE FOR ANY 
INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER 
BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN 
CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED 
HEREIN OR THE USE THEREOF. 
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License Agreement 

Stellar Phoenix Mailbox - Exchange Desktop 

Copyright © 1995-2010 by Stellar Information Systems Ltd. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix Mailbox - Exchange 
Desktop. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or 
distributing this software, unless you have a different license agreement signed by Stellar 
Information Systems Ltd. 

If you do not agree to all of the terms and conditions of this License then do not copy, 
install, distribute or use any copy of Stellar Phoenix Mailbox - Exchange Desktop with which 
this License is included, you may return the complete package unused without requesting 
an activation key within 30 days after purchase for a full refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each 
Licensed Copy of Stellar Phoenix Mailbox - Exchange Desktop. For purposes of this 
License, if you have a valid single-user license, you have the right to use a single Licensed 
Copy of Stellar Phoenix Mailbox - Exchange Desktop. If you or your organization has a valid 
multi-user license, then you or your organization has the right to use up to a number of 
Licensed Copies of Stellar Phoenix Mailbox - Exchange Desktop equal to the number of 
copies indicated in the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix Mailbox - Exchange Desktop may either be used by 
a single person or used non-simultaneously by multiple people who use the software 
personally installed on a single workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Phoenix Mailbox - Exchange Desktop, which are not 
expressly granted in this license, are entirely and exclusively reserved to and by Stellar 
Information Systems Ltd. You may not rent, lease, modify, translate, reverse engineer, 
decompile, disassemble or create derivative works based on Stellar Phoenix Mailbox - 
Exchange Desktop nor permit anyone else to do so. You may not make access to Stellar 
Phoenix Mailbox - Exchange Desktop available to others in connection with a service 
bureau, application service provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations. 
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Stellar Phoenix Mailbox - Exchange Desktop and all accompanying software, files, data and 
materials are distributed and provided AS IS and with no warranties of any kind, whether 
expressed or implied. In particular, there is no warranty for the quality of data recovered. 
You acknowledge that good data processing procedure dictates that any program including 
Stellar Phoenix Mailbox - Exchange Desktop must be thoroughly tested with non-critical 
data before there is any reliance on it and you hereby assume the entire risk of all use of 
the copies of Stellar Phoenix Mailbox - Exchange Desktop covered by this License. This 
disclaimer of warranty constitutes an essential part of this License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix 
Mailbox - Exchange Desktop in applications or systems where its failure to perform can 
reasonably be expected to result in a significant physical injury or in loss of life. Any such 
use is entirely at your own risk and you agree to hold Stellar harmless from any and all 
claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject 
matter and merges and supersedes all other or prior understandings, purchase orders, 
agreements and arrangements. This License shall be governed by the laws of the State of 
Delhi, India. Exclusive jurisdiction and venue for all matters relating to this License shall be 
in courts and for a located in the State of Delhi, India and you consent to such jurisdiction 
and venue. There are no third party beneficiaries of any promises, obligations or 
representations made by Stellar herein. Any waiver by Stellar of any violation of this License 
by you shall not constitute nor contribute to a waiver by Stellar of any other or future 
violation of the same provision or any other provision of this License. 

Copyright ©1995-2010 by Stellar Information Systems Ltd. All rights reserved. 
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Trademarks  

Stellar Phoenix Mailbox - Exchange Desktop® is a registered trademark of Stellar 
Information Systems Ltd. 

Windows 2000 Server®, Windows XP®, Windows 2003®, Windows Vista®,  Windows 7®, 
MS Office and MS Outlook are registered trademarks of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their 
respective companies. 
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Technical Support 

You can either Call Us or Go Online to our support section http://stellarinfo.com/support.php  

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Tollfree- Pre Sales 
Queries) 

1-877-778-6087 

USA (Post Sales Queries) 1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280149899 

Netherlands Pre & Post 
Sales Support 

31-208-111-188 

Worldwide +91-921-395-5509 

Skype Id stellarsupport 

Email Orders orders@stellarinfo.com 

Online Help 

• Chat Live with an Online technician 

• Search in our extensive Knowledge Base 

• Submit Enquiry (If our Knowledge Base does not answer your question) 
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About Stellar  

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data 
Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data 
Recovery Software for almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after 
accidental format, virus problems, software malfunction, file/directory deletion, or even 
sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS 
office repair tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, 
MS Outlook Express and MS Exchange useful in instances of data loss due to damages 
and corruption of Email. More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to 
ensure complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical 
drives, System Traces & Internet traces. Once the data have been removed using Stellar 
Wipe - Data File eraser utility, it is beyond recovery limits of any Data Recovery Software or 
utility. More Info >> 

For more information about us, please visit www.stellarinfo.com 
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FAQs 

1. Can I convert the OST files in any other format?  

Yes, Stellar Phoenix Mailbox - Exchange Desktop can convert messages in MSG and EML 
format. These files can be opened in MS Outlook and Outlook Express. 

2. I have forgot the path of my OST file can I search the OST file using the 
application? 

Yes, OST files can be searched in a drive or a specified folder. Click Find Outlook File 
option in the application and follow the process.  

3. While trying to activate the software, I’m getting an error message that the 
software is not installed correctly. How can I activate the software ?  

Follow the below steps to rectify the above mentioned problem : 

o Go to Control Panel. 
o Open Administrative Tools. 
o Then, open Services. 
o Now, right click on Crypkey License and click on start. 
o After starting the Crypkey Service, try to activate the software. 

4. How much time the Stellar Phoenix Mailbox - Exchange Desktop software will take 
to covert the file ? 

The scanning time depends upon the size of file. If the process is running that means that 
software is still scanning the file and you have to wait for scanning process to complete. 
Once scanning is complete you will get the converted file at destination location. 

5. I want to analyze the conversion process. Can I see the log report at a later stage? 

Yes, the application gives you option to save and view log report at a later stage. To view 
and save log, 

• On the View menu, select 'View Log Report'. 

• In the Stellar Phoenix Mailbox - Exchange Desktop application, click 'Save 
Log'.  

6. I have converted my OST file to PST. How can I import it in the outlook ? 

Please follow the below mentioned procedure to import the PST file : 

• Open Microsoft Outlook. 

• Click on File-->Open-->Outlook Data File. 
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• Select the PST file to be imported and click on OK. 

After this, you will be able to see second personal folder with the name of &rsquor;Stellar 
Phoenix Outlook PST Repair’ in which you will be able to see all the mail folders. 

7. What is OST File ? 

If you use Outlook as an Exchange Server client and do not use PST file to store your data 
(instead store your data on the Exchange Server), OST file allows you to work offline. OST 
file acts essentially as an offline copy of your data store on the Exchange Server. When 
you're working offline, all changes that you make to contacts, messages, and other Outlook 
items and folders occur in the offline store. When you go online again, Outlook 
synchronizes the changes between offline store and your Exchange Server store. 

   

 


